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1  About this Document

This manual provides detailed product related information, installation, configuration and
operation instructions for 3DLevelManager software. The manual is designed for trained
personnel. Please read it entirely and carefully before proceeding with installation of the
product.

1.1 Symbols in use
The following symbols indicate different sections of additional information as follows:

w IMPORTANT: An indication for additional information, tips, hints or an indication
1 of helpful additional knowledge.

WARNING: Indication of a potentially dangerous situation, which could result in
serious injury to persons and/or damage.

1.2 For your safety

Authorized Personnel

All operations described in this manual should be performed by authorized and trained
personnel only. For safety and warranty reasons, any internal work on the devices must be
performed by manufacturer authorized personnel only.

Appropriate Use
The 3DLevelScanner™ is a device designed for continuous level or volume measurement.

Warning about Misuse

Inappropriate or incorrect use of the device can give rise to application-specific hazards,
e.g. vessels overfill or damage to system components through incorrect mounting or
adjustment.

General Safety Instructions

The 3DLevelScanner™ is a high technology device which requires strict observance of
standard regulations and guidelines. The user must take note of the safety instructions
detailed in this manual, as well as country-specific installation standards, and all common
safety regulations and accident prevention rules.
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2 3DLevelManager™ Overview

2.1 Overview

The 3DLevelManager™ software is a configuration and monitoring tool for managing
3DLevelScanner™ devices.

The software supports various methods for connecting to the scanners, monitoring their
measurement readings, configuring their various parameters, log results and generating
various types of graphical reports.

This manual is compatible with SW version 3.2.0 and FW version 3.1.0.

2.2 Features
Major features of the 3DLevelManager software:

= Supports HART, RS-485/Multi-drop, GSM, GPRS and TCP/IP communication
interfaces to the linked scanners

®m  Supports all 3DLevelScanner models (S, M, MV and MVL) in a single or multiple
scanner arrangements

m Easy to use wizard-based parameter configuration tools including graphical
presentation and configuration aids

®m  Various logging options and displaying log information as time-lined graphs

= 3-Dimensional, animated graphical presentation of filling/emptying processes in MV
and MVL models

m  Built-in advanced analysis tools
®  Fully adaptable to user preferences (measurement units, display modes)

2.3 System requirements

The following minimum computer system characteristics are required for 3DLevelManager
to install and run properly:

Computer Hardware: Operating System:
m  Processor: Pentium 1GHz m Windows XP SP2 and Windows 7
= RAM: Minimum 1GB m  Microsoft .NET Framework 3.5 SP1

®m  Graphic resolution: Minimum 800x600

= Hard drive: Minimum 18GB free
memory on HD per year (Verbose log
enabled), Log file: 50MB/day

= CD-ROM drive
®  One serial port (built in RS-232 / USB)

3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved 3



Installation e Installing the software

3 Installation

3.1 Installing the software
1 Insert the BinMaster software CD into the CD drive.

2 Auto run should start automatically (if enabled in your computer). Otherwise, browse
the CD and execute the file BinMaster Level Manager.msi. The setup wizard appears

as shown:
rﬂ BinMaster 3DLevelManager 3.2.0 l = | = &
Welcome to the BinMaster 3DLevelManager 3.2.0
Setup Wizard

The installer will guide you through the steps required to install BinMaster 30LevelManager 3.2.0 on
your computer.

WARNING: This computer program is protected by copyright law and intemational treaties.
Unautherized duplication or distrbution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law

v NOTE: If a previous version of the software is already installed on your computer,
you will be offered with Repair and Remove options, for installing an updated
version or completely uninstalling the existing software.
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Installation e Installing the software

3 Click Next to proceed with the installation. The following screen appears:

ﬁl Binbaster 3DLevelManager 3.2.0 = =

Select Installation Folder

The installer will install BinMaster 30 evelManager 3.2 0 to the following folder.

To install in this folder, click “Mesd". To install to a different folder, enter it below or click "Browse ™.

Folder:
C:APragram Files [«8E8]4Binkd azter 3D Browse... |

Disk Cost.. |

Ingtall BinMaster 30LevelManager 3.2.0 for yourself, or for amyone who uses this computer:

" Evenone
& Just me

4  Click Browse to select a different installation folder if needed.

5 You may allow other users of this computer accessing the software by selecting
Everyone, or limit the access for yourself only by selecting Just me.

6 Click Next to proceed.

7 In the Confirm Installation window appearing next, click Next to begin the installation
and wait until the installation progress is complete:

-
ﬂ BinMaster 3DLevelManager 3.2.0

Installing BinMaster 3DLevelManager
320

BinMaster 3D evelManager 3.2 0 is being installed.

Please wait...
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Installation e Installing the software

8 The software installation is in process, and all the necessary files are being installed in
your computer. When complete, the following confirmation screen appears:

ﬁ BinMaster 30LevelManager 3.2.0

Installation Complete

BinMaster 30LevelManager 3.2.0 has been successfully installed.
Click "Close" to exit.

Please use Windows Update to check for any critical updates to the NET Framework.

9 BinMaster 3DLevelManager software installation is complete. Press Close to exit the
installation wizard.

Note the BinMaster 3DLevelManager shortcut icon which has been added to your desktop.

Binhaster

3DLevelManager
3.2.0
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Installation e Understanding 3DLevelManager Basics

3.2 Understanding 3DLevelManager Basics

The 3DLevelManager software is designed for both end users and technical personnel.
This chapter includes an overview of the user interface and general details regarding the
different modes of operation.

Connection Status

Once a connection is established, the software downloads all parameters from the
scanner. The download process may take few seconds depending on the communication
type and quality, during which the software will not respond and cannot be accessed.

Once a 3DLevelScanner is connected to the computer running the 3DLevelManager
software, the connection quality level is indicated by a 5-bar green indicator in the
Connection field (appears 1 minute after connection) on the upper left side of the window
(see figure below). The 5-bar indicates the real-time communication quality. If the
indication level drops (from 5 to 4, 3, 2 or 1 bars) for a significant period, we strongly
recommend to check the communication physical connection and any other element
related, such as drivers, network collisions, etc. 5 green bars indicates very good
communication quality, 3 yellow bars indicate a fair connection and 1 red bar indicates a
bad connection quality.

M Silo - Senior Technician - BinMaster 3DLevelManager | = | = |
(File Communication Device View Tools Help
Connection - Device Info
C el Luad l 1% Tag Name Sila
onnected yia L p
5 & Polling Address 0 Senal Number 709001458
RSB {CoMz) Firmware Version 3.0.123
Hardware Version 16
Davice Type - MV

- Measured Parameters ——

Volume
| 100.00 %

Level

I Distance
Level

| 22.95 .
Min Level
| 22.95 1.
Max Level
| 2333 ft.

Qutput Current
| 20.00 mA

Temperature
2TF

The 3DLevelManager in Senior Technician Mode
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Installation e Understanding 3DLevelManager Basics

Device Info

The following device information is displayed on top of the screen:

Connection status

Hardware interface and port number used for communication with the device

Device polling address

Tag Name (as defined for this connection)
Electronic card serial number

Firmware version of the electronic card
Hardware version of the electronic card
Device type (S/ M/ MV [ MVL)

Connection Device Info

Tag Name :

Serial Number :
Firmware Version :
Hardware Version :
Device Type :

@ Connected via

RS485 (COM4) Polling Address : 1]

Manual
709003549

2.9.988
20
MV

The Device Information area

Measured Parameters

The following device measured parameters are displayed on the right area of the screen,
as shown to the right:

First and second fields represent the calculated output
selected in the Output Settings under the Device menu. The
first field shows one of: Volume, Mass, Level or Distance
with its selected units. The second field shows the
percentage based on the selected output.

Distance (tab): Average distance between the top of the
scanner body and the material.

Min Distance: Minimum distance between the top of the
scanner body and the material.

Max Distance: Maximum distance between the top of the
scanner body and the material.

Level (tab): Average level between all echoes, measured
from vessel bottom.

Min Level: The distance between the lowest measured
echo to the vessel bottom.

Max Level: The level from vessel bottom to the material's
highest point (equals Empty Calibration—Min Distance).

Output Current: 4-20mA analog output current.

- Measured Parameters

Distance
[ 131t

[ 100.00 %

I Diztance
Level

| 4.50 ft.
Min Level
| 4,50 ft.

Max Level
| 4.50 ft.

Level

Duiput Current

| 20.00 mA
Temperature

| 12F
SNR

[ 7.9dB

Temperature: Temperature level around the antennas inside the vessel.

SNR: Signal-to-Noise Ratio measured inside the vessel, in decibels (dB). The SNR
indicates the energy of the transmitted signal compared to the acoustic noise inside

the vessel.

Note: Both temperature and SNR are displayed under technician modes.
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Installation e Understanding 3DLevelManager Basics

Standard Mode

Standard Mode is the default operating mode of the software. This mode allows
connecting and disconnecting the scanner, viewing of log graphs and 3D image and
performing basic grades analysis. Scanner configuration and Advanced Parameters are
disabled for this mode.

Technician Mode

Technician Mode allows configuration of advanced parameters which are not available
under Viewer mode (the default operating mode). Switching to Technician mode requires a
password.

To switch to Technician mode, choose Tools — Operating Mode — Technician Mode. You
will be prompted with the Password Request box. Enter the Technician mode password
and press the OK button. The Technician mode password is techAPM, and it cannot be
changed.

For Switching back to Standard mode, select Tools — Operating Mode — Standard Mode
from the Tools menu (no password required).

In Technician mode, there are 6 more tabs at the left area of the screen. These tabs allow
viewing of parameters, modifying part of them. The tabs include other useful tools such as
False Echo Mapping. This document describes the work under technician mode.

Senior Technician Mode

Senior Technician mode allows configuration of more advanced parameters which are not
available under technician mode. Switching to Senior Technician mode requires a
password.

To switch to Senior Technician mode, choose Tools — Operating Mode — Senior
Technician Mode. You will be prompted with the Password Request box. Enter Senior
Technician mode password and press the OK button. The Senior Technician mode
password is admin, and it cannot be changed.

Further differences between Senior Technician and Technician modes are detailed in this
manual where relevant.

No password is needed for switching back to a lower access mode: Select Tools —
Operating Mode — select the required mode from Tools menu (no password required).

Debug Mode

Debug mode can be accessed from Tools - Operating mode menu or by pressing F12.
This mode is strictly limited for BinMaster use and password protected.

3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved 9
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E Silo - Senior Technician - BinMaster 3DLevelManager | = | = | P4
File Commueication Device View Tools Help

Connection - Device Info
Tag Name Sila
Connected via 4
Palling Address [1] Serjal Number 709001458
S L Firmware Version 30123
Hardwara Version 16
Dlevice Types - MV

- Measured Parameters ——

Volume
| 100.00 %

Level | Ditance |
Level

| 22,951t

WMin Level

I 22,951t

Max Level

| 331

Ouiput Current
| 20.00 mA

The 3DLevelManager in Standard Mode

ﬁ Silo - Senior Technician - BinMaster 3DLevelManager |—':' = | P ‘
File ‘Communicstion Device: View Tools Help
Connection - Device Info
Y Tag Name Silo
Connected via 4
Palling Address [] Seral Number 709001458
it Firmware Version 3.0.123
Hardware Version 16
Dlevice Typs - MV

- Measured Parameters ——

Volume
| 100.00 %

Level | Distorce |
Level

| 22951t

Min Level

I 22951t

Max Level

I 2333 1t

Ouiput Current
| 20.00 mA

Temperature
27 F

SNR
| 56.6 dB

The 3DLevelManager in Technician Modes
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4  Connecting to 3DLevelScanner™

4.1 3DLevelScanner Connection Options

The 3DLevelManager Software enables communication with 3DLevelScanner devices
using different methods: RS-485, HART, GSM Modem, GPRS Modem and TCP/IP.
Communicating using an RS-485 is much faster than GSM, GPRS or via a HART
connection, therefore it is recommended to use standard RS-485 as communications
infrastructure.

Establishing a Connection

Press Communications » Connect... (or click the large red CONNECT button, or press
Ctrl+M) to initiate a connection between the 3DLevelManager and the connected
scanners. This opens the connection box which allows choosing the required
communication properties and establishing data connection between the software and the
scanner. The Connect window allows different communication setup for different
operators.

In the Connection Method field, select the communications interface used for connecting
the scanner to the computer and the software. For detailed information regarding the
communication options and settings, refer to page 22: Connect...

[ E Connect m
Connect

Flease select your preferred connection method:

Site
Site Name: [Manal =]

Conrection Method

& B54Es  GSM Modem)
" TCRAP " GPRS
 HART © GPRS +SMS

Configuration

Senal COM Part; l 4 - I

Faling &ddress; o -

Log Depth I Hormal v I

Connection window in Technician Mode

RS485 Connection
The figure below shows a schematic connection between a PC running the
3DLevelManager software and a 3DLevelScanner, using an RS-485 connection. For more

3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved 11



Connecting to 3DLevelScannerTM e 3DLevelScanner Connection Options

information about physical connections, refer to the BinMaster 3DLevelScanner Operating
Instructions manual.

PSIN 4.20mA RS-485
+ - - + + -

il g i

R5-485 (-}

R5-485 (+)

CONVERTER

RS-485 Connection

HART Connection

When using an RS-232/USB HART Modem, no hardware installation is required.The figure
below shows a local connection between a PC running the 3DLevelManager software and
a 3DLevelScanner, using a HART modem connection.

JDLevelManager
SOFTWARE

PLCIDCS

HART Modem Connection
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Connecting to 3DLevelScannerTM e 3DLevelScanner Connection Options

In this figure:

1 RS-232/USB Connection

2 3DLevelScanner

3 HART Modem

4  HART Resistor - 250 ohm, can be placed on any of the 4-20mA lines

GSM

The GSM option enables a modem-to-modem communication. This type of connection
requires a GSM modem connected to the scanner on one side, and a GSM modem
connected to the computer on the other side. The telephone number of the modem
connected to the scanner is required.

GPRS

The GPRS option allows IP connection to a remote 3DLinkPro with GPRS enabled. When
selecting this option, a TCP port must be opened in the local network and to be forwarded
to the computer running the 3DLevelManager. On pressing Connect, an SMS message
should be sent manually to the 3DLinkPro in the following format:

CALLAPM,[external IP address],[TCP Port],[APN],
A comma must end the SMS message.

For example:
CALLAPM,82.123.25.102,7024 internet,

TCP/IP

The TCP/IP option allows converting and transferring the RS-485 data over TCP/IP using
compatible converter. When establishing a connection to the TCP/IP converter, the local
IP address and the TCP port values must be set as defined in the converter.

GPRS + SMS

This option creates a GPRS connection without manual sending of an SMS message. A
3DLinkPro unit must be connected to the local computer running the 3DLevelManager
software in order to send the SMS message to the 3DLinkPro connected to the scanner.

GPRS + SMS Server

This option creates a GPRS connection without manual sending of an SMS. A 3DLinkPro
unit must be connected to a computer in the network in order to send the SMS message to
the 3DLinkPro connected to the scanner. This option is available for Senior Technician
and to be used when several computers in the same network can be connected to different
scanners and 3DLinkPros.

Multiple Scanner Connection

When connecting several scanners in a Daisy-Chain, the 3DLevelManager can be
connected to all scanners and a specific scanner may be chosen to be viewed at any time.
For this type of connection, each scanner must be set with a different polling address. One
of the scanners must be set with a polling address of 00.

3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved 13



Connecting to 3DLevelScannerTM e 3DLevelScanner Connection Options

Using the Phonebook

The 3DLevelManager stores a file named PhoneBook.ini which contains all connections
and their properties. Each connection can be named and stored automatically in the
phonebook file for further use. Based on the phonebook entries, a folder is created to store
relevant data such as grades analysis.

For viewing and editing the phonebook, select Browse to local folder from the File menu,
and select the file 'PhoneBook.ini'. Each connection entry should start in a new line and
with a different name.

The phonebook entries may look like:
[APM Scanner]
Polling=Multiple
Method=GPRS2
COM=7
LocallP=192.168.2.130
APN=internet
Number=+972541234567
LocalPort=7040

[Test 1]
Polling=Multiple
Method=485
COM=6

[TCPIP Connection]
Polling=00
Method=TCP
HostIP=192.168.2.48
HostPort=7040

14 3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved



First-time Configuration e Configuration Wizard

5 First-time Configuration

This chapter describes the recommended steps to be taken for configuration of the
scanner and bringing the scanner to full capability mode, in their recommended order.

51 Configuration Wizard

Use the 5-stage configuration wizard for first-time configuration of the 3DLevelScanner.

NOTE: Prior to 3DLevelScanner configuration, verify that the 3DLevelScanner

]
has the most up-to-date firmware version installed.

NOTE: Make sure the operating mode is set to Technician mode before trying to
open the Configuration Wizard. Technician mode password is ‘techAPM’.

NOTE: When working with scanners of firmware version later than 3.1.0, the
wizard pops up automatically when the scanner is set to factory defaults.

From the main menu, select Device — Configuration Wizard... (or press F4) to activate
the wizard.

The configuration wizard appears, starting at its first stage. [Device] View Tools Help

During wizard navigation, the following options are available at Configuration Wizard... F4
any Stage: Advanced Parameters. . F3
. . . . Current Output Settings.. F6
= Click €Previous to switch to previous stage. Output Settings.. 8
m  Click Cancel to exit the wizard without completion. No Upload Al -
parameter will be modified or saved to the scanner. Downlaad All £2

= Click Next-> to continue to the next stage. Device Reset N

m  Upload All available only for Senior Technician

Step 1/5: Set System Parameters
Step 1 allows choosing device name and preferred measurement units.

Set the device tag name/identity in the Tag Name field. This name is displayed on
the scanner screen and in the software window title once the device is connected.
The tag name field is limited to 16 characters.

Choose the preferred distance measurement unit in the Distance Unit field. The
available options are: meters, centimeters, millimeters, feet and inches.

Choose the preferred temperature measurement units in the Temperature Unit field.
The available options are: Celsius and Fahrenheit.

(@ click Next.
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First-time Configuration e Configuration Wizard

-
M Configuration Wizard M

| BINASTER

Tag Mame

I Marual

Distance Lnit

[ =l

Temperature Linit

I Fahrenheit LI

JDLevelScanner

Cancel I - F'revlnuel Mext - |

Set System Parameters stage

Step 2/5: Set Vessel Parameters
Step 2 allows identifying the vessel geometry including with a specific shape for exact
volume analysis.
The vessel major parts (top, center and bottom) schematic geometry can be chosen and
dimensions can be defined.
Choose the proper shape for the vessel top from the Top Shape field. The options
are: Flat, Cylinder, Dome, or Pyramid. Set the dimensions:
®m  For a cone shape, set the height and the top diameter of the cone.
= For a dome shape, set the radius of the dome.
®  For a pyramid shape, set the top section height, width and length of the vessel
top at the X and Y directions.
Choose the proper shape for the vessel center from the Center Shape field. The
options are: Cylinder or Cube. Set the dimensions:
=  For a cylinder shape, set the height and the diameter.
=  For a cubic shape, set the height, width and length of the vessel according to the
X and Y axis, respectively.
@ Choose the proper shape for the vessel bottom section from the Bottom Shape field.
The options are: Flat, Cone, Dome, or Pyramid. Set the dimensions:

®  For a cone shape, set the height and the bottom diameter of the vessel bottom
section.

®  For a dome shape, set the dome height.

16 3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved



First-time Configuration e Configuration Wizard

For a pyramid shape, set the height, width and length of the vessel bottom
section at the X and Y directions.
If the vessel shape is asymmetrical (for both cone and pyramid shapes), it is

possible to set the bottom center as an offset from the entire shape center. The X
Position and Y Position are the offset of the bottom section from the center.

@ Click Next.

3 ntaninl - Configueation Wissd
Stap 2i5: Sat Vessal Paramaters

;Tm:-‘--
|

alisg

Ny

Set Vessel Parameters stage

Step 3/5: Set the Device Position
This stage allows specifying the exact location of the scanner on the vessel’s top.

Set the device location according to the previously defined top vessel shape using
one of the following methods.

Drag the device on screen, or
Enter the X and Y coordinates in Device Position fields at the top right corner.

Set the Offset from Vessel Top if the scanner is not installed on the vessel ceiling
but a standpipe or socket is used, or the scanner is lowered using neck extension
or head-body separation kit.

The offset referred to the top part of the antenna body and not necessarily to the
flange.

NOTE: The Side View image will display the changes of the scanner (if the

ﬂ NOTE: The device Z position is being calculated automatically.

offset parameter is used) and will show the scanner when mounted on the
ceiling slope or a horizontal rooftop.

NOTE: In Senior Technician Mode it is possible to set the angle manually.

(@) click Next
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, —
E Manual - Cenfiguration Wizard ﬂ

Step 3/5: Set the Device Position

- Device Position [f]

| o7oe | ooz | ZZm
% e z

Offzet From Veszel Top: i 0.001

Device Horzontal Angle: i)

— Side View

=

Diameter # g
[ 1o | wroer | DOfz2k

Note: Use the mouse to Drag and Drop the device on
the screen or set the position manually

Cancel ] <--Previ0us| Mest > l

Set the Device Position stage

Step 4/5: Set Filling Points

This stage allows configuration of the vessel filling points. Up to 10 filling points may be
defined. The following figure describes a schematic top view of the vessel and the filling
point locations.

@ Set the filling points using one of the following methods:

®m  Bring the cursor to the desired location over the vessel top shape and left-click
the mouse to set the filling point, or:

®  Press Add and enter the X, Y and Z) coordinates in the Filling Points table and
press Enter button, press Enter after every number entered.

To edit a field: double click the field, enter the required value and press enter.
To delete a filling point, mark the corresponding row and click Delete.
To delete the full list of filling points, click Clear All.

@ Click Next.
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Step 5/5: Set Process Details

-
W pfanual - Configuration Wizard

Step 4/5: SetFilling Points

Diamneter

#

| 1B

0708 6t

v
T

Note: Use the mouse Left Click on screen in the exact
position of the filling points or set the points manually

[ievice Pasitior [f]

ams [ om2 | 223
b ¥ z

Offzet Fram Veszel Top: | 0.om

Device Horizontal Angle: 3R P |
Filling Poirk

% =

0.034 -0.055

Delets | EIaarAIII

Cancel I <--Previ0us| Mest - _l

e

Set the Filling Points

This stage allows configuration of the vessel full and empty calibration levels. The
following figure describes a schematic view of the vessel and the emptying point locations.

® ®00

Set the distance from the flange (or top of the horns body) to the material 100% level
(see figure below) using the Full Calibration field.

Set the distance from the flange to the material 0% level (see figure below), using the
Empty Calibration field.
Distance from flange to bottom — represent the maximal distance between the
flange (or top of the horns body) to the bottom of the vessel, double clicking this field
sets the empty calibration level with the same value.

Press OK.
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First-time Configuration e Advanced Configuration Parameters

Measurements are from the scanner’'s horns

’
E Manual - Configuration Wizard w
Step 5/5: Set Process Details
Diesice Position [ft]
078 | Doz | 2z
b i z
Offset From Weszel Top: | 0.0
Device Horizantal Angle: o'
9—:} Filling Paint
i % e |
0.034 -0.055
sdd | Delete | Clearsl
Process Details
Full Calibration {ft]
| 013
Empty Calibratian {ft]
Diameter kS b ' 1575
I 1840t I 7088 l oz Distance from Flange 1o Botloin
Note: Set the Full and Empty calibration level. A

Cancel | <=+ Previous

Set Process Details

If parameters were modified during the
wizard process, the following box
appears (figure to the right) offering an
option to upload all parameters to the
scanner.

m  Click Yes to upload parameters to
the scanner and to close the wizard.

= Click No to close the wizard without
uploading parameters to the scanner.

r- - =
Upload to device? ﬂ

% Some parameters had been changed and not yet uploaded to the
V' device,
Would you like te upload all parameters to the device?

®m  Click Cancel to close the window and stay in the wizard.

52 Advanced Configuration Parameters

Following the completion of the configuration wizard, open the advanced parameter
window (press Device->Advanced Parameters...) in order to set general parameters
such as Material Slope and Dumping Time. Other parameters may be configured and fine
adjustments can be done at a later stage. Refer to page 28: Advanced Parameters... for

detailed instructions and descriptions.
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5.3 Grades Analysis

Once configuration is complete, a Grades Analysis should be performed for viewing the
returned echoes from the material surface and using the analysis results to adjust the
scanner. Refer to page 45: Analyze... menu for detailed instructions.

54 False Echo Mapping

In vessel installations with high sockets, struts or agitators, corrugations, as well as with
material buildup and welded joints on the vessel walls, reflection interference may occur
which may result in erroneous measurements. The False echo mapping feature detects
and marks these false echoes to be ignored during volume measurement. It is advised to
generate the false echo mapping when the vessel is empty for detection of all potential
interfering reflections.

The false echo mapping feature is located under the Tools menu, and allows automatic
scanning (enter a range to scan), manual scan (enter the range and threshold) and to
reset all false echo mapping (including Auto False Echoes). Refer to page 46: False Echo
Mapping.

55 Log Viewer

The 3DLevelManager collects all data received from the scanner and stores it on the local
computer's hard drive. Selecting View-Log File... or pressing CTRL+W opens the logs
view application. When a scanner is connected, the log graph starts building from the
connection point. Browsing old logs can be done by pressing the browse button [...] and
selecting the folder for viewing the log file contents.

The logs are saved in HTML format and are stored in a folder named with the connection
time and date. For more information, refer to page 42: Measurement Logs.

5.6 3D Image Profile

The 3DLevelManager is equipped with a highly useful feature of generating and displaying
a 3-dimensional, graphical representation of the visual mapping contour of the stored
material as scanned by the 3DLevelScanner MV and MVL models. For more information,
refer to page 39: 3D Image.
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6 Software Menus

This chapter describes the different functions available under the software menus and sub-
menu options, ordered as they appear in the menu.

6.1 File menu

Load parameters for Browsing... (Ctrl+B)

Opens a saved parameters file (.CFG file) for browsing only. Uploading to the scanner is
not possible.

Load Parameters to Device... (Ctrl+D)
Opens saved parameters file for uploading to a connected scanner and for browsing.

Save Configuration... (Ctrl+S)

Saves all parameters (Basic settings, Output settings and, Advanced Settings) to a CFG
type file. You can choose the location and the file name to be saved.

Browse to Local Folder...

Open the local 3DLevelManager Application Data folder. This folder includes different log
files and grade analysis files.

Generate a New Log File

Stops storing data on current log file and generates new file with an updated time and date
stamp. A new log folder will be created under the installation directory, for storing log files
with all data from the scanner. At least 2MB/day free hard drive space should be reserved
for the logging activity in normal operation connection (not Verbose).

Exit (Ctrl+X)
Exits the 3DLevelManager software.

6.2 Communications Menu

This menu allows connecting and disconnecting to /from the device as well as polling
address selection, communications quality test and log file / history viewing.

Connect... (Ctrl+M)

Opens the connection box which allows setting of the required link and communication
properties and to establish a data connection between the software and the scanner(s).
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In Standard mode, RS-485, TCP/IP or HART options are available. When switching to a
higher operation mode, more options become available. This chapter describes all options.

In the Connection Method field, select the communications interface used for connecting
the scanner to the computer and the software. The available options are:

m RS485: Connection over RS-485 bus.

m  Select the serial COM Port number the RS-485 Converter is connected to, and enter
the scanner polling address.

m Click Connect.

f W Cannect &
Connect

Flease select your preferred connection methad:

- Site
Site Mame; |Manual vl

- Conriection Method

& R5485 " G5M (Modem]
O TCRAR " GFRS
 HART " GPRS +5MS

Configuration

Senal COM Part: I 4 hd I

Palling Address: o -

Log Depth: I Moarmal - I

Cotinet

m  TCP/IP: The scanner is connected via a TCP/IP network to an RS-485 connection.
m  Select the site name.
m  Select the scanner polling address.

m  Set the Server IP address and IP port number in the right pane. Server IP is the
device converting RS-485 to TCP/IP.

m  Click Connect.
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E Connect
Connect
Please select your preferred connection method:
- Site Further Configuration
Site Name: [fest =] Servet P Address: 192.166.67.19
- Conriection Method Setvet [P Pott 5DDD

T RS4B5 " G5M [Modem)

@& TCRAP " GFRS

" HART " GPRS + 5M5
Configuration

Serial COM Part: I? -i

Falling Address: oo -

Log Drepth: INormaI vl

Cotnect

—

®  HART: The scanner is connected using a HART modem.
m  Select the serial COM port number the HART modem is connected to, and enter the
scanner polling address.
= Click Connect.
m  GSM (Modem): The scanner is connected using a local GSM modem.
m  Select the serial local COM port number and enter the scanner polling address.
m  Select the site name and enter the phone number of the other side modem.
®m  Click Connect.
rE Connect
Connect
Flesse select your preferred connection method:
+ Site — + Further Configuration —l
Site Mare; lﬁ Phane Mumber: mm
Connection Method
I Rsa8s & GEM [Madem]
(" TCRAFP " GPRS
" HART " GPRS+SMS |
- Configuration
Serial COM Poart: l? vI
Paling &ddress: 0o hd
Log Crepth: m
Cannect
m  GPRS: The scanner is connected through the internet over GPRS using 3DLinkPro.
= Enter the local IP port number and the scanner polling address.
= Click Connect.
m  Send an SMS message from a mobile phone to the scanner to initiate the connection.
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GPRS + SMS: The scanner is connected via the internet using 3DLinkPro. The link
uses SMS messages over a local GSM modem connected to the computer.

Select the site name.

Select the serial port of the 3DLinkPro connected to the computer.

Select the scanner polling address.

At the right pane, set phone number of the 3DLinkPro connected to the scanner.
Set the computer local IP port.

Set the external IP address (usually the router IP address).

Set the APN word of the 3DLinkPro connected to the scanner.

Click Connect.

E Connect
Connect
Flease select your preferred connection methad:
- Gite — Further Configuration
Site Name: [ - Phone Mumber: [ 123123458456
- Conriection Method Rt | 3000
" RS488 " G5M (Modem] 1= BT Es
 TCRAR " GFRS
= APM: 1 interet
= H&RT & GPRS +5MS

Configuration

Senal COM Part: I4 -vi

Polling &ddress: oo -

Log Depth: |N0rmal "l

GPRS + SMS Server: (available only under Senior Technician mode. To be used by
BinMaster authorized distributors) The scanner is connected via the internet using
3DLinkPro. The link uses SMS messages using a GSM modem connected to a
computer on the local network.

Select the site name.

Select the scanner polling address.

At the right pane, set phone number of the 3DLinkPro connected to the scanner.
Set the computer local IP port.

Set the external IP address (usually the router IP address). External IP address can
be obtained using web services such as www.whatismyip.com.

Set the APN word of the 3DLinkPro connected to the scanner.

Set the TCP Port of the computer connected to the modem sending the SMS
message. Default port number is 9669 and it should not be changed

Set the IP address of the computer connected to the modem
Click Connect.
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-
M Connect

Connect

Flease select your preferred connection method:

|- Site — [ Further Configuration—————————————
Site Name: [Test 'ri Fhone Number: | 123123456056
|
- Connection Method————+—————— ‘ Fort: | 7040
~ RS485  G5M [Modem) | Iz 527117960
~ TCRAP " GPRS
APN: 1 internet
i~ HART (" GPRS +SMS

Part: i 9663
=2 I 192168.2103

~ Configuration I
Serial COM Faort: ]? I

Polling &ddress: ] -

| Log Depth: ]Verbose i l

# GPRS +5MS Server FSMS Sefvgr ————————————————————————
|
|

Cohnect ‘

_

m  Polling Address: Enter the scanner polling address when connected via daisy-chain
connection (RS-485 Multi-drop). Address range: [00 to 63 or Multiple]. When selecting
Multiple, each scanner must have its own, unique address.

Disconnect
Disconnect software communication to the device.

Polling Address Selection...

Available when the manager is connected in Multidrop. Use the dialog box to select polling
addresses of multiple 3DLevelScanner scanners to be monitored using a Multidrop
connection.

3 Polling Address Selection... E=NEEE

The selection below sets the polling addresses of scanners

to he maonitored in the multidrop bus
|N0rmal Seanning vi

M 8 e CEee T sl ree e

[RITOT] Tea  O s  a

{5 RO T i < e A

G =L O T e e T

T4 [12 T2 28 M3 M4 M5 [ 60

[C& i@ 20 2280 T3 sl [ ebd [kl

R A 2 s O s R A A

A i e T Y e e

oK Caneel
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Check the check-boxes with the polling address per each scanner to be monitored. Log
files will accumulate data for all checked scanners.

®  Normal Scanning scans all the selected scanners. This is the default value and
should not be changed.

®  Slow Scanning adds a delay between polling of each scanner. Useful when
communication speed is low

®m  Pause Scanning stops communicating with other scanners except current scanner to
retrieve information, until setting back to normal or slow scanning mode.

w NOTE: The scanning option parameter selection on top-right exists only on older
1 software versions, and should not be modified.

Communication Quality Test
Analyzes the connection quality of the RS-485 cable

connected between the computer and the scanner. If | % Communication Quality Test i

packets not answered, or received with errors, the R e s

cable must be checked for existence of proper

resistors on both sides and verified to be of shielded %of packetsrotanswerzd [ 00

and tWISted-pall’ type % of packets received cormactly l 1000

An example for a good test result: an averaged delay % of packels eceed iheros [ 00

of 97msec (very low), no lost packets and no errors RGN B S

received. NENRENINERERRRRRES

m  Click Restart Te_st to restart testing. The test will s Tost | Pl |
cycle through until terminated.

m  Click Close to terminate and close the window.

Communication Log File...

The Communications Log File contains logged data corresponding to the communications
between the software and the scanner connected to it. Selecting this option opens the file
in an Internet browser window. The file format is HTML and it might be required for
technical support use.

Communication History...

The Communications History contains logged data corresponding to the communication
events between the software and the scanner connected to it. Selecting this option opens
the file in an Internet browser window. The file format is HTML and it might be required for
tech support use.

6.3 Device Menu

This menu allows accessing to advanced configuration options. Some of the menu options
are disabled on Viewer mode, and become available under Technician mode.

Configuration Wizard... (F4)

The configuration wizard provides a wizard-based, graphical-aided tool for configuring a
connected 3DLevelScanner. At the first run after software installation or following a new
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scanner connection, all wizard steps must be followed and all parameters should be
configured according to the Installation Preparation Form (IPF) filled prior to the installation
and approved by the BinMaster Customer Support or by your local distributor.

Refer to page 15: Configuration Wizard for a detailed description regarding the
configuration wizard.

Advanced Parameters... (F5)

Opens the 'Advanced Parameters' box, where the algorithm parameters can be adjusted.
This window is available under Technician and Senior Technician modes only.

The various fields can be downloaded or uploaded from/to the scanner. Any changed
parameter, if not uploaded to the scanner, can be discarded using the Cancel button at
the bottom. We recommend consulting BinMaster before changing any of the parameters.

When connecting to a 3DLevelScanner with earlier firmware version (2.x.x), the Advanced
Parameters window will looks different and may include other visible parameters.

In Technician Mode, the user has limited access to the parameters.

®  Qutput Dumping Time: Sets the history dump window time of the scanner. This
parameter increases stability and improves the SNR. Default value: 300 seconds,
minimum value: 60 seconds.

®m  Steepest Material Slope: Set the maximum material slope. The scanner verifies all
echoes for not exceeding the slope. Default: 35°. Recommended setting: between 30°
to 45°.

®  Minimal SNR [dB]: The lowest SNR threshold. Below this level, the sensor does not
measure and the reading remains unchanged. Default: 13dB. Setting the minimal
SNR to a value lower than 10dB is not recommended.

m  Restrain coefficient [%]: Sets the level of preference of echoes from shorter
distances over echoes from farther distances. 100% = no preference of closer echoes.
0% = total preference of the first echo. Default: 10%.

= Side Margins [m/ft]: Allows tolerance in echo recognition to vessel walls (see figure).

Used for creating a tolerance in case of unknown vessel width/diameter, and when a
tolerance is required for detecting points on the vessel walls.

Echo within the tolerance/margin range is transformed to the vessel wall on the X-Y
plane and will not be eliminated in calculation. Default: 1m (3.28 ft.).

m  Top Dead Band [Discard/Don’t Discard]: To be used only when echo cancelation
using mapping range for short distances is not possible. The unit discards all echoes
up to the full calibration. Default: Don’t Discard. Discard: The sensor scans material
only at a distance larger than full calibration distance. Don’t Discard: Distances
smaller than full calibration distance are scanned as well. If measured distance to the
content is smaller than full calibration, the full calibration distance is presented.

®  Bottom Margins [m/ft]: Allows adding a tolerance in echo recognition from the bottom
shape (but not flat) (see figure).
This feature is used for creating a tolerance in the case of unknown vessel

dimensions, and when a tolerance is required for detecting points from the bottom of
the vessel. Default: 1m (3.28 ft.).
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I = Bottom Margins

Historic Log Sampling Period: Sets the interval between measurements that are
saved into the local memory. By default, the scanner does not store the log. The
settings are ranged between 1 to 60 minutes. If the scanner has been reset due to
powering off or via the software, this parameter resets to its default value and the log
will not proceed with data accumulation.

Auto False Echo: Enable/Disable, Sets the algorithm to automatically calculate false
echo levels, enabled by default. Setting this parameter to Disable stops the scanner
from continuously calculating the false echo levels and keeps the last image of false
echoes. If the false echoes are manually reset, the level is set to O.

User False Echo: Enable/Disable, Sets the algorithm to consider the false echo
mapping created manually by the user (enabled by default). Setting this parameter to
Disable causes the scanner to ignore the manual false echoes.

Max Capacity [tons]: The total capacity of material within the vessel.
Max Emptying Rate [tons/hour]: The maximum emptying rate.
Max Filling Rate [tons/hour]: The maximum filling rate.

It is recommended to set the maximum capacity and Filling/Emptying rates according to
the actual process in the vessel.

1& Advanced Parameters M
Advanced Parameters |

Output Dumping Time 200 oL
Steepest Matenial Slope 35,000 s
Top Dead Band |D0n't Dizcard vl
Hiztaric Log Sampling Perniod lDD niot generate Histol v}

Lizer Falze Echoes |Enable v}

kg Falze Echoes | Enable - }

Maw. Capacity I 100.000 tar
Max Emptying Frate: | 100,000 torith
Mz, Filing Rate | 100.000 tondh

|
Dowrload &1 Uplaad Al |
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Advanced Parameters in Technician Mode

m  Mechanics Type [l/ll]: Sets the type of configured scanner. The options are | or Il. It is
extremely important to set the mechanics type to avoid wrong calculations.

®  CFAR Sensitivity: Constant False Alarm Rate detection — an automatic threshold
algorithm. Setting the sensitivity adds gain to the CFAR threshold (default: 9db).
Adding 6db doubles the gain [dB]. This is an adaptive and robust algorithm for
detection of targets in a noisy environment.

m  User False Echo Sensitivity: Refers to the Manual False Echo mapping created by
the user. The minimum extra gain required to distinguish between real echoes and
mapped false echoes. Decrease sensitivity if false echoes prevent the device from
tracking the true level. Increase the sensitivity if false echoes are not ignored. Default
value: 1.2.

m  Auto False Echo Sensitivity: Refers to the auto false echo calculation done by the
algorithm. The minimum extra gain required to distinguish between real echoes and
mapped false echoes. Decrease sensitivity if false echoes prevent the device from
tracking the true level. Increase the sensitivity if false echoes are not ignored. Default
value: 1.2.

M fdvanced Parameters i_

Advanced Paramelers T Beams Activation I

[ utput Durping Time [ = e
Steepest Material Slope |_':E'mg_ > g
Mechanics Type Il -
CFAR Sensitivity o dB
Miniral SNF 'T dbl
Restrain Cosfficient l# 5
Side Marging 1.000 i
Bottom Marging 1.000 it
Top Disad Band [DontDiscad =]
Historic Log Sampling Perod Urkriowe vi
User False Echoss Enable vi
Aul False Echoes m
User False Echoes Sensitivity 1.200
Autn False Echoes Setisitivity 1.200
Max. Capacity Wﬁnﬂu_ ton
Mas. Enplyirig Rate E00.000 tondh
Maw. Filing Rate E00.000 tondh

Download &l Lo el | Cancel I
Advanced Parameters for Senior Technician

®  Beams Activation tab allows choosing manual or automatic (by the algorithm) beams
selection. By default, the beams are selected automatically. Part of the beams will be
removed depending on silo dimensions.

High, Med and Low Frequency beams represent three separate transmissions which
emit signals from all three antennas simultaneously.
30, 90, 150, 210, 270 and 330 degrees directions represent 6 separate directional
transmissions which improve the algorithm's analysis of the returned echoes. All 6
transmissions are transmitted in the Med frequency.
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Beams can be enabled or disabled by removing the check box from the Auto Beams
Selection box. A selection of less than three directional beams is not allowed. Only a
selection of at least three consecutive beams is possible, for example: Direction 30,
Direction 330 and Direction 270.

The conditions for an automatic beam selection are as follows:
I If the Z position is larger than 2.5 times the diameter, and the Z position is
lower than 30m (98.425ft): only High and Med beams are activated.

il. If the vessel diameter (or one of the horizontal dimensions in the case of a
cube) is less than 8m (26.25ft), or the Z position is less than 4m (13.125ft):
The Low beam is disabled.

ii. If the vessel diameter (or one of the horizontal dimensions in the case of a
cube) is less than 4m (12.125ft): only the High beam is activated.

=  Automatic Beams Range: enabled by default. This option sets an automatic range
limitation to the echoes selection for each transmission separately. This limitation is
visualized in the Grades analysis window as the orange vertical line.

-
M Advanced Parameters ||

Advanced Parameters Beams Activation

v High Frequency.
¥ Med Frequency
v Low Frequency

v 30 degrees direction
v 90 degrees direction
v 150 degrees drection
¥ 210 degrees direction
v 270 degrees direction
v 330 degrees direction

[~ Auta Beams Selection
W Automatic Beams Fange

Drowenload &l Upload Al Cancel

L

Beams Activation under Senior Technician Mode

3DLevelManager Operating Instructions © 2012 BinMaster all rights reserved 31



Software Menus e Device Menu

[ High 1 Med 1 Low 1 Dir30 1 Dird0
Dirl50 T Dir210 T Dir270 T Dir330 T Al Beams

Analyze

30,000 ===t e T ¥ — Grade
g g g ! g g g g g ! g [¥ — Threshold
25,0004 ----tonondofon e poe b L TR e [~ —Grages £

H H H ; H H H H H ; H [ —aFE
20000 -boorn bt e — e | —rasee

15,000 4

10,000

so00 |- bt

u u u u u u u u u
r 3 9 0 11 12 13 14 15 18

Example of range limitation orange line
= Download All: Downloads all parameters from the scanner to the software.
NOTE: Three options are available for downloading all parameters from the
device: using the Main Screen, using the Device menu and using this
Advanced Parameters window.
= Upload All: Uploads all parameters from the software to the scanner.
NOTE: Four options are available for uploading all parameters to the device:

L ]
using the Main Screen, using the Device menu, using this Advanced
Parameters window and using the last step of the wizard.

m  Cancel: Closes the Advanced Parameters windows without up/downloading from/to
the scanner. If the Upload All button is not pressed, the changes will not be saved.

Current Output Settings... (F6)

The Current settings window is designed to control the 4-20mA output signal. The window

includes two major functions:

= Current Simulation: The output current can be simulated by setting Volume (%), or
Current (mA). This feature is useful for synchronizing the PLC and verifying of
identical read values for both the scanner and the PLC. When the simulation is active,
a red blinking signal appears, indicating: Simulation is Active.

= Current Output Mode: Allows setting the output to send the standard 4-20mA signal,
or optionally to send a reverse signal: 20-4mA. The last option sets the scanner to
output a fixed value.

ﬂ NOTE: Notice the simulation indicator, shown when the simulation is active.
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-
M Current Output Settings...

Cuiirent Simulation

I Select...

Apply

Cancel

Output Settings

Curent Output Mode

| Standard [4-20 ma]

Fixed Curtzht Yalue

| 4

Drownload Al

L plad &l Cancel

Output Settings... (F7)

The Output Settings defines the displayed calculation and how the 4-20mA output
behaves. The output type of Volume (default), Mass, Level or Distance can be selected.

Volume:

Calculation Using Silo Structure —calculates the volume based on the silo structure
defined using the configuration wizard. The displayed units can be selected to be

available to the user.

r
M Dytput Settings.

==

- Dutput Type:

I~ Diztance

- Calculshion Usirg

i+ Silo Structure
I Levelvalume T able

( Distanceolume T abls

%

- May Scale

L]

Upload

Dizplay Units ———

-

- Descaption

Open Table l

Dutput Current calculated according to the
30LevelScanner's c‘onfig_uraﬁon.

Yalure 15 displayed aceording to the selectsd
urits,

Mate: Output Current and % display are set

according fo the Full and Empty Calibration levels:

‘Cancel

Calculation Using Level-Volume Table — allows setting a linearization table based

on level to volume conversion
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Iax Scale

M |inearization Parameters

- Output Thpe —

* Volume
I Mass
7 Level

I Distance

[lisplay Lrite—

4 - |

&

- Calculation Using
7 Silo Stucture
= LevelVolume Table

" DistanceVolume Table

Degcrption -

Dutput Current calculated based on an edited
Levelvolume table.

Yolume is digplaved according to the selected
urits,

Frezs Open Table ta edit the table.

Maote: Dutput Current and % display are set
according to the Full and Emotu Calibration levels.

= Calculation Using Distance-Volume Table — allows setting a linearization table
based on distance to volume conversion (to be done the same as above).

®  Mass:

= Calculation Using Fixed Bulk density — Calculation of mass based on the silo
structure and volume calculation at a certain level. The bulk density value can be

|palmad I Open Table Carjzel
<
§ Linearization Table = |
i ]listance [ra] WVolume [%] | Yolume [m™3]
1 0.00 1665 0.00 0.00
15.40 007 0.25
3 0.50 1815 018 0.62
4 0.75 14.50 033 1.14
5 1.00 14.65 053 1.83
& 1.28 14.40 078 272
7 1.50 1415 110 383
& 1.75 1390 1.49 518
] 2.00 1365 155 6.81
10 2.25 13.40 250 8.73
11 2.50 1315 315 10.96
12 2.78 1250 389 13.54
13 3.00 1265 473 16.49
14 3.28 12.40 569 19.84
15 3.50 1215 E77 2359
16 375 11.50 798 27.80
17 4.00 11.65 93 32.46
18 4.25 11.40 10.79 3762
19 4.50 11.15 12.42 43.30
20 478 10.90 14211 49.51
21 5.00 1065 16,15 5E.29
22 15.00 0ES 37.28 33903
23 15.10 055 38.02 34161
24 15.20 0.45 3862 34371
25 15.30 0.35 39.10 34533
26 15.40 024 99.48 34670
27 15.50 014 99.76 34768
28 15.60 0.04 99.96 348,37
29 15.70 -0.06 100.00 34852
30 16.80 018 100.00 34852
31 15.90 -0.26 100.00 34852
32 16.00 038 100.00 34852
oK Canicel | Apply | Shiw Vessel

Level-Volume Linearization Table

entered as Tons/M® or Ibs./ft® units.
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WD | inearization Parameters =
Ouitpit Type Calculation Using————
17 Volume ¢ Fized Bulk Density
¥ Mass I Leveltass Table
7 Level i~ Digtance-Mazs Table
|1 Distance i~ LevelMariable Bulk Denzity
I DigtariceVariable Bullk Density
|
| Description

| Displap Urits -
1]’0,.]3 (Metric] = tazz Calculation and output current vill be
| calculated based on the 3DLevelScanner's
= = copfiguration and byrultiplying the walume by a
Derzity [Tars ¢ m™3]- fined bulk density valus entered at this stage.
| Mate: Dutput Current and % display ate set

|
| 1 5.0000 | according to the Full and Empty Calibration levels.

Upload | Open Table Caricel ok

Calculation Using Level-Mass Table — conversion of the calculated average level

directly into mass

E Linearization Parameters ) S
Clutput Type - Caleulation Llsing —
i Molume I~ Fized Bulk Density
% Mass 5 LevelMass Table
i Level I” Distance-Mass Table
|17 Distance 17 Levelariable Bulk Denzity
" Digtanceanable Bulk Denzty

| Display Urits - | | Description
[ ITDnS [Metric] - | Mass Calculahon ignores the 30LevelScanner's
| | configuration and display/output the mass based
| on theconfigured table: Press Open Table to edit
Mak Spale ———— the table,

| | Mote: Dutput Current and 2 display are sat
| accarding ko the Full and Empty Calibration lesels.

Ialmsd ‘ Open Table Caricel
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r
B |inearization Table _§:§ I
Mazs [%] Mazs [Tons]
0.00 0.00
R 7217 2274170
3 2213 1767 74,22 85,094.16
4 22.75 17.05 7B17 87.230.16
5 23.38 16.42 7802 8945263
E 24,01 1579 97T 91,464, 54
7 2463 1517 81.43 93.368.84
o 2526 14.54 83.00 95,168.49
E| 25,89 13.91 84,43 96,86E.45
10 2651 13.29 85.88 98,465.68
11 2714 1266 8719 99.969.13
12 27 1203 88.42 101,379.80
13 2839 11.41 89.57 102,700.50
14 29.02 10.78 90,65 103.934.40
15 2965 1015 91,685 105,084.30
16 0.27 953 9259 106,153.20
17 30.90 8,90 93.45 107.144.10
18 31.53 8.27 94,25 108.060.00
19 32158 7.E5 94.98 108,903.70
20 32.78 7.02 95.EE 109.678.20
21 3341 £.39 96.28 110,386.50
22 34,03 577 9E.54 111.031.80
23 34.EE 514 97.35 111.61E6.50
24 35.29 451 9781 112,143,590
25 35.91 389 98.22 112.617.00
26 36.54 326 98.59 113.038.70
27 3717 263 98.92 113.412.00
28 3779 | 2.01 93,20 | _113.738.70
29 38.42 1.38 99,45 114,024,590
30 39.08 075 93,66 114,270.50
kil 3967 013 93.65 114.473.50
32 40.30 -0.50 100.00 114,654,80
Ok Cancel Apply Show Yeszel

Level-Mass Linearization table

m  Calculation Using Distance-Mass Table — conversion of the calculated average
distance directly into mass (to be done same as above)
=  Calculation Using Level-Variable Bulk Density Table — conversion of the
calculated average level into volume, based on silo structure and multiplying by the
bulk density value at that level to convert into mass
- M | inearization Parameters 2
Output Type —— = Calculahion Using -
£ Wolume | {7 Fired Bulk Dengity
# Mass | 7 Leveltass Table
7 Level 7 Distance-Mass Table
O Distance o Levelvanable Bulk Dersity
I Distanice-yaniable Bulk Density
_Displayt_LInits - _| ._Descriptiun —_—_— : — :
Im ass Caleulation is baged on known sila shape
| and average bulk derzity at a certain level.
— gm — Mate: Output Current and % display are set
Max Seale —— ‘ according ta the Full and Emply Calibration levels.
| daloae ‘ Open Table Cancel
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W Linearization Table |
Distance [m] Mazz [%] Mazz [Tonz] [Density [Tons /
39.80 0.00 0.00 0.00
18.30 7217 82,741.70 1.02
17.67 T74.22 85,034.16 1.02
17.05 JE17 87,330,168 1.02
16.42 78.02 89,452 B3 1.02
15.73 7977 91.464.54 1.02
1817 81.43 93,368,584 1.02
14.54 83.00 95,168.49 1.02
13.91 84.43 96,566.45 1.01
13.29 85,88 98,465 B3 1.01
1266 87.19 99,969.13 1.01
12.03 85.42 101.379.80 1.01
11.41 8957 102.700.50 1.01
10.78 30 65 103.934.40 1.01
1015 91.65 105.084.30 1.01
953 9253 106.153.20 1.01
2.90 9345 10714410 1.01
8.27 94,25 108.080.00 1.01
7.Eh 94.98 108.303.70 1.01
7.0z 95.E6 109.678.20 1.01
B.39 9E.28 110.386.50 1.01
BT 9654 111.031.60 1.00
514 97.35 111.E1E.50 1.00
4.51 97.581 112.143.30 1.00
3.83 95,22 112E17.00 1.00
326 93.59 113.038.70 1.00
263 98.92 113.412.00 1.00
2m 99,20 113.733.70 1.00
1.38 99 45 114.024.30 1.00
0.75 99 6 114.270.50 1.00
013 99 85 114.473.50 1.00
-0.50 100.00 114.654.80 1.00
Ok Cancel Apply Show Yeszel

Level-Mass table using Variable Bulk Density

Calculation Using Distance-Variable Bulk Density Table — conversion of the
calculated average distance into volume, based on silo structure and multiplying by
the bulk density value at that distance to convert into mass (same as above)

Level — Output the Level of material

E Linearization Parameters S ES
OutpLt Thpe — 7
I Wolume
I Mase
i+ Level
" Distance
- Dlizplay Unitg ———— [ [legcription - = — T
P = By gelecting this option, the scanner's 4-20md
| output will reprezent the level of the material from
the bottar of the silo, and will dizplay on the
| manager the average level of the material.
| Mote: Dutput Curent and % displap ste sat
according ko the Full and Ermpty Calibration lesels.
|
Upload [gzn | =bls Carize| 1] 4
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Distance — Output distance to material

~w Linearizanen Farameters | _ﬁ
Output Type————
I Yolume
1" Mass
1 Level
= Distance
| Display Urits | Deseription —
l ‘m = ] By selecting this option, the scanner's 4-20ms
| autput will represent the distarice to the material
—_—— frami the top of e anaducer's case, and will
dizplay on thie manager the average distance o
the matenal.
Mate: Output Cureent and % display are set
according to the Full and Emoty Calibration levels. |
Upload 1= e Caricel ok

Output Settings windows buttons functionality:

Upload — sends all information to the scanner. If not all parameters are properly
configured, an alert pops up with the problem indicated.

Open Table — when available, the table can be edited according to the requirements
Cancel — discards all changes and close the window

OK — keeps settings and advise upload the changes to the scanner

Table buttons and functionality:

OK — saves the configuration. Uploading from the output settings window will be
required

Cancel — discards all changes and closes the table window
Apply — upload all updated settings to the scanner

Show Vessel — enlarges the table window and shows the silo structure and level
indication when selecting a table row

Operations on the table:

o Right clicking the row number allows: Add Row Above, Delete Row, Clear
Rows Above, Clear Row, Clear Rows Below

0 Right clicking the # on the top left of the table allows clearing the entire table
o0 Right clicking the editable column allows clearing the column

Upload All (F2)
Upload all parameters from the software to the scanner.

Download All (F3)
Downloads all parameters from the scanner to the software.
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Device reset
Allows the following resets options:

Restart Scanner: Sends a restart command to the scanner. The internal DSP boots
and starts building the auto false echoes and dumping values. The initialization
process takes about 30 seconds. The scanner will perform a new search for the
correct measurement.

Reset to Factory Defaults: Resets most of the system parameters to their factory
default settings. All parameters must be re-defined following this operation. The
following parameters remain unchanged: 'Output Dumping Time' and 'Steepest
Material Slope'.

Reset Advanced Parameters: (available only with firmware versions 3.x.x) Resets all
advanced parameters. This function will not reset the '‘Output Dumping Time' and
'Steepest Material Slope'. Scanner configuration will not reset in the Configuration
Wizard.

6.4 View Menu

3D Image...

Generates and displays a 3-dimensional graphical representation of the visual mapping
contour as scanned by the 3DLevelScanner MV or MVL.

The legend scale to the right side displays the measured level.

To rotate the 3D image, press and hold the mouse left key and drag over the image at
the desired rotation direction.

The Manager application generates 3D mapping frames depending on the connection
rate. To watch the animation, click Watch Log. A new 3D image and a browse
window opens. Select the desired log folder (located under the Logs folder). Use the
video controls to play, stop, move backward or forward or scroll along the time line.
The interval in milliseconds (msec) sets the frame time interval. The minimum value is
1msec.

For switching between a zoomed-out view of the silo and a zoomed-in view of the
material surface, click the top right button or double-clicking the 3D image itself.
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| 2 %o = E =
|

Zoom Out

Visual mapping window

Show Vessel Geometry Cnly
v Show Device
Show Fill, Empty Points

Material Color ...

Show Ases

Actrvate Pan Mode

Save Image As...

Mizc b

Wiew .

Visual Mapping Options
Right-click the mouse to open the additional features menu:
m  Show legend: Displays the level scale on top right corner.
=  Show Material Surface Only: Displays the surface of material only.
m  Show Vessel Geometry Only: Displays the vessel geometry without material.

= Show Device, Fill, Empty points: Displays the device, filing and emptying points
relative to the vessel geometry.

= Material Color...: Choose a desired material color.
m  Show Axes: Displays the x-y-z axes.
m  Activate Pan Mode: Switches from image rotation to panning.

m  Save Image As.... Performs a screen capture of the entire window for saving as an
image file.
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Misc: Opens a sub-menu with the following options:
Show Silo Dimensions Wall: Displays a grid with dimensions, similar to the zoomed-

in image.

®  Draw Silo Grid (Wireframe): Displays a wireframe over the material surface.
m  Show Solid Material Color: Displays the material in a solid color.
=  Fill Bounds with Material: Shows the complete material around the surface, or the

surface only.

= Hide Top Shape: Hides the top part of the vessel (if not flat).

m 3D Algorithm Accuracy: Controls the number of points in the image. Available
options are: Normal, Good and Best. Default option: Normal. Changing the option is
not recommended since a high value consumes most graphic card resources.

= View: Opens a sub-menu with different viewing angle options.

3D Movie...

The Visual Mapping feature allows building and viewing a movie based on the generated
3D representations as frames. When activated, a browser window automatically opens for
selecting the desired logs folder for generating the movie.

The 3D movie feature works only with MV or MVL scanner model logs.

After selecting the log folder, it is possible to play the movie, pause, skip to next scene or
return to previous one, jump to start or to the end.

It is also possible to select the polling address of the desired scanner to view and to set an
interval time in milliseconds, the interval time define the pause between two 3D image

shots.

R Visual Vision 300

[=[E=] = |

Zoom In

20.18

10.25

18.34

interval [msec] 400

©

05/02/2012 16:39:06

o]

Qoo oveo.. -

1;5:29 Watch log

Grades FW 2.x.x Logs...

Allow viewing previous grades analysis window conducted on scanners with FW version

2.X.X.
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Allow viewing previous grades analysis window conducted on
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Measurement Logs... (Ctrl+W)
Loads a log file and displays a chart presentation.
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m  The Log option displays charts for Distance (m/ft), Volume (%), SNR (dB) and
Temperature (°C/°F) over a time line as shown. Log files are saved as the connection
is established. The files are saved in a local folder.

For viewing older log files, press the [...] browse button. A browsing window opens,
showing the Logs folder for choosing a different log file. The file names include the
date and time of the connection.

®  The LogViewer application includes three menus with the following options:

= File>Browse to Local Folder — Opens the Windows Explorer application in its files
location

= File->EXxit — Exits the LogViewer application

m  Preferences->Distance Unit — Allows changing the displayed units in the Distance
chart between: m, cm, mm, ft, inches

m  Preferences>Temperature Unit — Allows changing the temperature units between
Celsius and Fahrenheit

m  Preferences=>Time Offset — allows adding time offset (between +12 to -12 hours)
from the local computer’s clock

m  Help>About — Opens the About window

-
M - LogViewer

File Preferences Help

Please select a log file ta view ; !C:\Usars\AF‘M\AppData\Loca\\APM\3DLeve|Manager\Logs\HS485 2011-07-07 09-10-144

Start Date: (2011-07-07) Poling Address:

[ml

" i . i " L b L . : i i i . i : P P P :
08:10 0920 09:30 09:40 08:50 10:00 10:10 10:20 10:30 10:40 10:50 11:00 11:10 09:10 09:20 09:30 09:40 09:50 10:00 10:10 10:20 10:30 10:40 10:50 11:00 11:10

SNR Temperature

[dB] 504 -

09:10°09:20 09:30 09:40 09:50 10:00°10:10 10:20 10:30 10:40 10:50 11:00 11:10 09:10 0%:20 09:30 05:40 05:50 10:0010:10 10:20 10:30 10:40 10:50 11:00 11:10

Finished Loading. A

—

Log File graph representation

In Multiple Mode, the software monitors all the scanners selected in the Polling Address
Selection (see page 26). For viewing a different scanner log file, select the scanner
Polling Address in the drop-down list at the top-right corner.
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Use the preference menu for displaying logs in different distance units (m, cm, mm, ft.,
inch), different temperature units (Celsius, Fahrenheit), different time zone (hours
difference) and different regional settings (using dots or commas as digit separators).

Working with the Graphs

Zoom-in, zoom-out and pan options are available for all charts created by the
3DLevelManager: Grades Analysis, Log and Historic log.

m  Zoom-In: Choose a rectangular area you wish to zoom in and place the mouse cursor
on the top left corner of it. Left click the mouse and drag it to the bottom right corner of
the required area, making sure not to release the mouse button until the entire
required area is selected.

= Zoom-Out: Place the cursor of the mouse inside the graph, left click the mouse and
move it from bottom right to top left and release the mouse button.

®  Pan: Right click the mouse button and hold it inside the graph area. While moving the
mouse, the graph will pan to the sides.

®m  Back to default view: In the Grades Analysis window, double clicking on the graph
pops up a box for data reloading confirmation.

Historic Log...

The scanner allows storing logs in its local memory. Use the Historic log settings in the
Advanced Parameters feature to enable this option. To view the log from the scanner
memory, select the Historic Log... option.

When selecting the Historic log, a box appears asking for selection of the required log time
to be retrieved from the scanner. Once download is complete, a log viewer window opens
displaying the logs. The log data is then saved under the Historic log folder.

7 -
 -Historic Log., =5
Historic Log... _ .
- Date
Lo | 180 Dapz Ago
™ 30 Lag IT Hours Ago
Start Carmcel | Cloze | Load From Files

Dimensional representation of the log. The option is not available under

Note: This option allows choosing a 3D Log option which creates a 3-
Technician Mode.
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6.5 Tools Menu

Analyze... (Ctrl+2)

The Analyze tool allows a selection of different signal types downloaded from the scanner
at a preferred time resolution and generates a chart-type report for each scan. On
choosing this menu option, the following box appears:

Select All Grades Info or Grades or False Echoes to analyze the scanner behavior
in the vessel.

Click Start to begin the analysis once the desired options are checked. The tool will
then start downloading the signals from the scanner. This stage takes a few seconds
or minutes to complete, depending on the communication speed. Once completed,
the analysis results window appears.

Click Cancel to stop the download.
Click Close to close the Analyze... window.

Click Load From Files and select the file from the appropriate folder for uploading a
certain signal (channels, grades, or false echoes).

All Grades Info: Checking this option causes the analyze tool to download the
Grades, Grades Threshold (controlled by an automatic algorithm), False Echoes and
Auto False Echoes. The files are saved under a separate folder named with the tag
name, date, and time. Note that when checking this option, the rest of the options
cannot be selected.

Grades: Checking this option causes the analyze tool to download all the echoes
received by the scanner (energy values returned from each object in the vessel). The
file is saved under a separate folder, named with the tag name, date and time.

False Echoes: Checking this option causes the analyze tool to download all false
echoes mapped under the False Echoes Mapping. This reveals the strength of each
false echo at each distance. The file is saved under a separate folder, named with the
tag name, date and time.

Continuous Grades: This feature allows running the grades analysis continuously for
later viewing of the changes in material and scanner behavior over time for an in-
depth analysis. The Continuous Grades feature is also possible with all scanners
connected in multi-drop connection. Use the Every field for setting the pause interval
between two scans, the minimal value is 3 minutes between scan stop to new scan
that starts.

Channels / Raw Data: Checking this option causes the analyze tool to download the
nine signals returned to the transducers. Enter the maximum scanning range in the
Max Range field. All files are saved under a separate folder, named with the tag
name, date and time.

The Raw Data option is to be used only when a BinMaster personnel requires this
operation. This feature is intended for engineering use only.

w NOTE: A multiple selection of the Grades, False Echoes and
Channels/Raw Data options can be made, by checking the desired signal
type to download. In such case all files are saved under the same folder

(named with the tag name, date and time).

NOTE: Measurements are freezing during the raw data extraction process.
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NOTE: Grades and False Echoes functions are compatible with FW
versions prior to 3.X.X.

[ 3 panual - Analyze.. I_i P
Continuous Grades
Analyze... CEvefint [ 3
v &l Grades Info
[T Giaile:
[T Falz ELlves

I™ | Charmels --i MaHFiangg;i m

Etal'l Lot | Cloze |

Wiew Grades Pa/
2uw

C:AUsershElvappliataslocalBintaster 301

The analyze dialog

False Echo Mapping...

Allows the user to map out false echoes according to the grades analysis (and based on
them).

®m  Scan — Automatic false echo mapping between the set ranges From/To

m Manual Scan — set a constant level at the defined threshold between the From and
To distances

m  Reset All False Echoes — delete all false echoes done by the Auto False Echo
algorithm and in the False Echoes Mapping created by the user.

m  Start Scanning (or Reset Mapping) — press to start the calculation.

7 T |
W Falze Echoes Mapping.. l_i_l

- Falee Echoes Mapping

detion Type

|Scan ;I

From

| m
1o

| m
Thigshald

Start Scanning I
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Update Firmware...

Uploads a new firmware to the device electronic card.

= Click the [...] browse button to select the firmware file (*.Idr) to upload to the device.
= Click Start Update to upload the file to the device.

®  Click Cancel Update to stop the update process.

m  Click Close to close the window.

-
M pdate Firmware ﬁ

wWarning! [ Recavery Mode
Do not tum off the 3DLevelScanner while updating.
Select the file to be uploaded to the 3DLevelScanner

File Marme : |

Start update |

Canies| |jpdate |

* IMPORTANT: Once the firmware update process is complete, reset the device to

1 factory settings by clicking Reset to Factory Settings in Advanced Parameters...

(F5), page 28. When using software version 3.0.0 and above and upgrading to

FW 3.0.8 and above, it is not necessary to reset the device to factory defaults
since all settings are done automatically.

Downgrading a scanner firmware from version 3.0.0 and above to older versions
such as 2.9.843 is not recommended. On such downgrading, the scanner will
return to its factory defaults and an upgrade to the original type will be necessary.
Please contact BinMaster when facing such requirement.

Upgrade Model...

Upgrades or downgrades between S, M and MV versions.

m  Select the relevant type to be upgraded to.

= Click OK,

m A password is required for upgrading to a higher type (M/MV). The password can be
supplied by your local distributor as a text file, or acquired from BinMaster. Copy the

password from the provided text file (license number) into the empty field in the dialog
box.

v Note: Once the upgrade process is complete, the device will automatically reset
1 and initialize itself.
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- —
W | ograde Davice E

Please select the requested application : | *l

0K Cancel

Operating Mode

Standard Mode: In this mode, parameter modifications are disabled. Switching from
Standard mode to other modes requires a password.

Technician Mode: In this mode, basic parameter modifications are enabled. A
password is required. The password is ‘techAPM’

Senior Technician Mode: In this mode, advanced parameter modifications are
enabled. The password: ‘admin’ is required.

Debug Mode: A password protected development mode. Access is allowed for
manufacturer personnel only.

6.6 Help Menu

The Help menu consist of two functions:

Operation Manual — Opens this document
About (F1) — Opens the about window with the version details.
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SmartBob2 weight & cable
Rotaries

Capacitance probes
Vibrating rods

Diaphragm switches

Tilt switches

Ultrasonics

Radar

Aeration

Call us for dust & flow detection devices, too!

]E Jamieson Equipment Company
5314 Palmero Court
Buford, GA 30518
800.875.0280

- — —  www.jamiesonequipment.com
Jamieson Equipment Co.
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